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Abstract:The utilization concerning EPUB file format is extremely 
recommended to document of scientific research into digital form. 
Because of the availability through support from various devices and 
software that makes the EPUB format is not a dependency towards 
one developer. Sigil is one of the free application as EPUB editor. In 
addition, Readium which is a browser plug-in Google Chrome is as an 
EPUB file reader application. It supports playback of audio and video 
that produces the interactive scientific research. 
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Pendahuluan 

Seorang penulis saat ini bisa membuat karya ilmiah yang lebih 
menarik perhatian pembaca dan tidak monoton dengan teks dan 
gambar namun juga animasi, visualisasi serta video kedalam 
karyanya. Selain dari penyajian, karya ilmiah juga telah 
bertransformasi dari tumpukan-tumpukan kertas ke digitalisasi. Karya 
ilmiah berbentuk digital sangat memudahkan orang untuk mengolah, 
mengakses, menyebarluaskan serta mengarsipkan filenya. Hal ini 
merupakan salah satu dampak positif digitalisasi. Bahkan, karya 
ilmiah atau dokumen kuno bisa dihidupkan kembali dan 
disebarluaskan dengan mengubahnya ke bentuk digital. 

Dalam proses digitalisasi karya ilmiah, seorang penulis harus 
memperhatikan format yang digunakan untuk publikasi karya ilmiah 
karena sangat  mempengaruhi daya tarik pembaca baik dari sisi 
lisensi (apakah pembaca harus menggunakan aplikasi berbayar untuk 
membaca karya ilmiah), aksesibilitas (apakah karya ilmiah dapat 
diakses menggunakan PC, Tablet, Smartphone), interaktifitas (apakah 
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pembaca bisa menggunakan fitur atau hanya akses membaca saja), 
dan ukuran file (semakin kecil ukuran file akan lebih diminati namun 
tanpa mengurangi kualitas). Oleh karena itu, sebaiknya menggunakan 
format yang mendapat dukungan secara luas, baik untuk 
pembuatannya maupun aplikasi pembacanya. 

Dari uraian diatas maka penulis ataupun pembaca harus 
mampu membedakan format digital yang ada. Saat ini banyak format 
file untuk penyimpanan file digital diantaranya adalah epub, Azw, 
PDF, doc dan beberapa format jenis lainnya. Pemahaman format ini 
sangat penting bagi para penulis yang ingin menyimpan formatnya 
secara digital agar isi dari karyanya bisa dimanfaatkan secara optimal. 

 

Perbandingan Beberapa Format File 
Ada berbagai macam format yang bisa dimanfaatkan untuk 

pembuatan karya ilmiah; 

1. Format File EPUB 
EPUB (Electronic Publication) merupakan salah satu format 

digital book yang merupakan format terstandarisasi, 
diperkenalkan  oleh International Digital Publishing Forum (IDPF) 
pada Oktober 2011. EPUB menggantikan peran Open Book sebagai 
format buku terbuka. EPUB terdiri atas file multimedia, html5, css, 
xhtml, xml yang dijadikan satu file dengan ekstensi.1 

2. Format File AZW 
Format AZW adalah format yang dikeluarkan oleh Amazon, 

yang dikhususkan untuk aplikasi Kindle, dengan kata lain format 
AZW sangat bergantung pada aplikasi Kindle. Untuk membuat 
format AZW seorang penulis tidak cukup memiliki aplikasi Kindle 
saja namun harus memiliki perangkat Kindle yang dapat dibeli 
melalui situs belanja online Amazon (https://www.amazon.com). 
Dengan menggunakan perangkat tersebut file yang berformat 
HTML, PDF, DOC, JPEG, GIF, PNG dan BMP akan dikonversi oleh 
Amazon ke format AZW, kemudian hasil konversi akan dikirim 
melalui surat elektronik.  

                                                
1
 Ibnu Saefullah, Langkah Cepat Menerbitkan Buku Digital Secara Mandiri.  

(Jakarta: Kainoe Books, 2016), hal. 16  

https://www.amazon.com/
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Beberapa keunggulan format AZW di Aplikasi Kindle adalah; 

 Teks yang Adaptif 
Jika teks dibesarkan atau dikecilkan, maka halaman akan 

menyesuaikan sendiri, teks-teks akan bergeser secara otomatis 
menyesuaikan ukuran huruf dan ukuran layar. Akibatnya, 
nomor halaman tidak lagi statis.  

 X-Ray 
Ketika sedang membaca, kemudian menemukan frase yang 

kurang dimengerti  dengan mengetuknya maka Kindle akan 
memberitahu informasi tentang teks terkait, dengan 
mengambil referensi dari halaman lain dan sekaligus dari 
Wikipedia.  

 Table of Content 
Dengan menggunakan fitur ini, daftar akan otomatis tampil 

dan akan memudahkan untuk berpindah dari satu konten ke 
konten lainnya. 

 Dictionary 
Jika menginginkan arti kata, maka cukup dengan mengetuk  

kata tersebut, maka hasil terjemahan akan muncul dengan 
referensi kamus Oxford. 

 Bookmark 
Salah satu fitur untuk menandai suatu halaman. Misalnya 

penanda batas akhir bacaan. 
 DRM (Digital Rights Management) 

Format AZW dibatasi dan terkunci dengan ID perangkat 
Kindle pada saat membelinya yang terdaftar secara otomatis. 

3. Format File CBR 
Comic Book Archive (CBR) digunakan untuk membuat 

dokumen gambar,  terutama dalam pembuatan  komik  digital.  
Aplikasi yang digunakan untuk membuat dan  membaca format 
CBR adalah CDiplay.   

4. Format File HTML 
HTML (Hyper Text Markup Language) adalah sebuah bahasa 

pemrograman yang digunakan untuk membuat sebuah halaman 
web untuk menampilkan teks, grafik, animasi maupun audio dan 
video. HTML merupakan teknologi canggih dengan beberapa 
alasan, HTML menggunakan teks biasa, HTML bekerja pada semua 
komputer karena memiliki format universal, HTML 
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merepresentasikan maksud dari sebuah dokumen dan untuk 
pengaturan tampilannya dibantu oleh teknologi CSS, HTML 
bersifat gratis dan tersedia untuk siapa saja.2 

5. Format File PDF 
PDF (Portable Document Format) adalah sebuah format 

berkas yang dibuat oleh Adobe Systems pada tahun 1993 untuk 
keperluan pertukaran dokumen digital. Format PDF digunakan 
untuk merepresentasikan dokumen dua dimensi yang meliputi 
teks, huruf, citra dan grafik. Format PDF merupakan  format 
dokumen yang sangat  populer karena tidak tergantung pada satu  
software.  

Untuk membuat file berformat PDF ada beberapa aplikasi 
yang ditawarkan antara lain; doPDF, PrimoPDF, PDF24 Creator, 
Foxit Reader, atau menggunakan Microsoft Office 2007 dan 2010. 
Juga bisa dilakukan konversi ke PDF secara online dan gratis. 
Untuk membuka file format PDF dibutuhkan aplikasi Adobe 
Reader, selain itu juga  bisa  menggunakan aplikasi Foxit Reader 
dan  Web Browser.  

6. Format File Doc 
Format Doc (Document) adalah format file hak milik Microsoft 

merupakan format yang dibuat menggunakan aplikasi pengolah 
kata (word processor) Microsoft Office Word 2003 dan versi 
sebelumnya. Format ini mendukung gambar, tabel namun tidak 
mendukung audio dan video. Dan perlu diketahui bahwa format  
Doc ini  sangat rentan dengan virus. 

7. Format File docx 
Docx merupakan pengembangan dari format Doc, untuk 

pembuatan format  ini menggunakan Microsoft Office Word 2007 
keatas. Perbedaan mendasar antara Doc dan Docx adalah; 

 Doc adalah format binary sedangkan Docx adalah format XML 
(Extensible Markup Language) sehingga membuat Docx lebih 
portabel terhadap aplikasi berbasis web. 

 Ukuran file Doc lebih besar dibanding Docx, sehingga 
berpengaruh pada saat file tersebut dibuka Docx terasa lebih 
ringan dibandingkan dengan Doc. 

                                                
2
 Harris, Andy & McCulloh, Chris. HTML, XHTML and CSS All-in-One Desk 

Reference For Dummies. (John Wiley & Sons, 2008), hal. 12 
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 Format Docx mempunyai tingkat ketelitian yang tinggi pada 
saat dikompresi. 

 Doc rentan dengan virus sedangkan Docx mempunyai 
ketahanan terhadap serangan virus makro, sehingga Docx lebih 
aman pada saat bertukar file. 

 Aplikasi Microsoft Office Word 2007 dan versi setelahnya dapat 
membaca file Doc, sedangkan Microsoft Office Word 2003 dan 
versi  sebelumnya tidak dapat membuka file Docx. 

 Fitur Microsoft Office Word 2007 dan versi setelahnya lebih  
banyak  dan lebih animatif. 

8. Format File RTF 
Format RTF (Rich Texs Format) dibuat berdasarkan spesifikasi 

DCA (Document Content Architecture) yang digunakan oleh IBM 
untuk SNA (System Network Architecture). Hal ini digunakan untuk 
mentransfer file yang berformat WYSIWYG (What You See Is What 
You Get) yang menjembatani platform yang berbeda seperti 
Windows dan Machintos. Format ini dapat dibuat menggunakan 
aplikasi Wordpad, Microsoft Office Word, OpenOffice. 

Jika dibandingkan dengan format Doc dan Docx, format RTF 
lebih aman dari serangan virus kemungkinan disebabkan RTF tidak 
sepopuler Doc/Docx namun dari sisi ukuran RFT jauh  lebih besar 
ukuran filenya. 

9. Format File ODT 
Untuk word processing ekstensi yang digunakan adalah 

(*.odt). Word processing ODT ini mirip dengan Doc dan Docx, 
hanya saja ODT gratis, berbeda dengan Doc ataupun Docx yang 
berbayar. Open Office juga memiliki fitur pengolah kata modern 
seperti AutoCorrect, AutoComplete, AutoFormat, Styles and 
Forma_ing, Text Frames and Linking, Tables of Contents, Indexing, 
Bibliographical References, Illustrations, Tables.  

Program ini sangat mudah digunakan untuk membuat memo 
cepat, sangat stabil dan mampu untuk membuat dokumen dengan 
banyak halaman serta banyak gambar dan judul heading. Selain 
itu, kelebihannya adalah pengaturan formating untuk bullet and 
number yang sangat mudah. 

Untuk lebih rinci, berikut perbandingan format file 
berdasarkan ketersediaan fitur yang akan disajikan pada Tabel.1. 

 



Rahmadani Siregar – Karya Ilmiah Interaktif Menggunakan Format File EPUB 

70 
 

Tabel 1. 
Perbandingan Format File Bersarkan Ketersediaan Fitur 

For
mat 

Dukungan terhadap Fitur 

DR
M* 

Gamb
ar 

Tabe
l 

Audi
o 

Vide
o 

Int
era
ktif
ita
s 

Fle
ksi
bili
tas 

Stan
dar  
terb
uka 

EPU
B 

√ √ √ √ √ √ √ x 

AZW √ √ √ √ √ √ √ x 

CBR x √ x x x x x √ 

Html x √ √ √ √ x x √ 

PDF √ √ √ √ √ √ √ √ 

Doc x √ √ x x x √ x 

Docx x √ √ √ √ x √ x 

RTF x √ √ √ √ x √ x 

ODT x √ √ √ √ x √ x 

*) DRM (Digital Rights Management) adalah pengaturan hak akses 
terhadap file digital. 
 

Dari tabel diatas, tampak jelas bahwa format Epub mendukung 
semua fitur modern yang bisa menampung bukan hanya teks dan 
gambar, namun juga audio dan video yang membuat format epub ini 
sangat cocok untuk buku buku edukasi ataupun karya ilmiah yang 
dinamis dan interaktif. 

 

Format EPUB (Electronic Publication) 

Format EPUB merupakan format yang sering digunakan untuk 
pembuatan Buku Digital (eBook). Buku Digital adalah publikasi yang 
terdiri dari teks, gambar, video, maupun suara dan dipublikasikan 
dalam bentuk digital yang dapat dibaca di komputer maupun 
perangkat elektronik lainnya.3 Sehingga kumpulan karya ilmiah dapat 

                                                
3
 Ibnu Saefullah, Op.cit.,  hal. 1 
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digabung menjadi satu file dalam bentuk buku digital dengan format 
EPUB.  

Ada beberapa pertimbangan dalam penentuan EPUB sebagai 
format yang direkomendasikan yaitu; 

 Bersifat terbuka: yakni pemakai memiliki kebebasan untuk 
menjalankan program, mengubah program, mendistribusikan 
program.4 Dengan keterbukaan ini maka penulis dan pembaca 
dapat menggunakan EPUB secara bebas.  

 Aksesibilitas: kesuksesan sebuah karya ilmiah digital apabila 
dapat diakses dari berbagai perangkat seperti komputer, 
tablet, smartphone dan ketersediaan aplikasi gratis untuk 
membacanya seperti aplikasi pembaca AZARDI, Calibre, Plugin 
Firefox, Plugin Google Chrome; Android menggunakan aplikasi 
pembaca FBReader, Ideal Reader, iOS dengan aplikasi 
pembaca Ireader; dan aplikasi pembaca lainnya seperti Kobo 
eReader, Blackberry playbook, Barnes and Noble Nook, Sony 
Reader. 

 Interaktifitas: karya ilmiah yang interaktif apabila pembaca 
dapat menggunakan fitur seperti pembaca bisa memberikan 
komentar, membagikan tulisan, memutar suara, animasi 
bahkan menonton video. Sehingga pembaca tidak merasa 
bosan seperti halnya membaca dalam bentuk kertas.  

 Fleksibilitas: yakni kemampuan EPUB untuk menyesuaikan 
tampilan dengan perangkat yang digunakan. Begitu juga 
dengan penyesuaian tata letak teks (reflowable). Sehingga 
tidak perlu melakukan zoom in dan zoom out. 

Untuk membuat format EPUB, dibutuhkan EPUB editor seperti 
Sigil, Calibre, EPUBee Maker, dll. Dalam tulisan ini aplikasi Sigil yang 
akan dijadikan sebagai EPUB editor, dan Readium sebagai aplikasi 
pembacanya. 

Walaupun EPUB adalah format yang dapat menampung semua 
jenis konten digital (text, image, audio,video) namun hal ini juga 
menjadi sisi kelemahan Epub sendiri. EPUB hanya cocok digunakan 
untuk perangkat digital seperti Komputer, Ebook Reader, Tablet 
ataupun Smartphone. Format EPUB bisa dikatakan kebalikan dari 

                                                
4
 Abdul Kadir. Pengenalan Sistem Informasi. (Jakarta: Penerbit Andi, 2014) hal. 

210 
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format PDF yang sangat cocok untuk format cetak karena tata letak 
dan fontnya bersifat statis. 

 

Sigil: EPUB Editor 
Sigil merupan aplikasi open source yang digunakan untuk 

melakukan editing file EPUB. Sigil dapat dijalankan pada multi sistem 
operasi baik di Windows, Mac maupun Linux. Karena sifatnya open 
source, Sigil memiliki banyak versi sesuai dengan kepentingan 
pengembang aplikasinya. Oleh karena itu, dalam tulisan ini 
menggunakan versi terbaru Sigil 0.9.6 yang diluncurkan pada tanggal 
18 Juni 2016 dengan fitur-fitur terbaru seperti5; 

 User dapat mengontrol navigasi dan template yang diletakkan 
di direktori Preferensi. 

 User dapat mengatur lokasi direktori sementara. 

 Penambahan dukungan Qt Stylesheet untuk mengidentifikasi 
dan memuat file yang disimpan di direktori Preferensi. 

 Penambahan antarmuka Plugin untuk mendukung elemen 
EPUB3. 

 Penambahan opsi metadata. 
Selain penambahan fitur terbaru Sigil juga dikenal memiliki 

beberapa keunggulan yaitu; 

 Mendukung penggunaan beberapa bahasa antarmuka 
aplikasi. 

 Atarmuka yang mudah difahami WYSIWYG ( What You See Is 
What You Get). 

 Dukungan UTF-16. 

 Tersedia tampilan versi buku, versi kode program, dan 
tampilan akhir. 

 Pembuatan daftar isi otomatis. 

 Pengaturan metadata. 

 Fitur pemeriksaan ejaan. 

 Fitur pencarian teks dan penggantian teks. 

 Fitur import file. 

 EPUB validator. 

                                                
5
 GitHub, Inc. [US]. New Features.< https://github.com/Sigil-

Ebook/Sigil/releases/tag/0.9.6>. Diakses pada tanggal 11 Oktober 2016. 

https://github.com/Sigil-Ebook/Sigil/releases/tag/0.9.6
https://github.com/Sigil-Ebook/Sigil/releases/tag/0.9.6
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Sebagai langkah awal untuk memperoleh aplikasi Sigil versi 

0.9.6 dapat diunduh di laman resmi https://github.com/Sigil-
Ebook/Sigil/releases/tag/0.9.6 dan untuk panduan proses instalasi 
pada sistem operasi Windows dapat dilihat pada Gambar berikut;  

 

https://github.com/Sigil-Ebook/Sigil/releases/tag/0.9.6
https://github.com/Sigil-Ebook/Sigil/releases/tag/0.9.6
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Langkah selanjutnya, untuk mempermudah proses editing 
dibutuhkan aplikasi tambahan yaitu Microsoft Office Word yang 
digunakan untuk pengetikan, pengeditan, dan pengaturan tataletak 
teks, sekaligus menyimpan file ke dalam format HTML (Web Page, 
Filtered), karena jika hal itu dilakukan langsung pada editor Sigil maka 
dibutuhkan penguasaan Bahasa HTML. Berikut ini langkah-langkah 
dan penjelasan penggunaan Sigil; 
o Buka aplikasi Sigil 
o Tambahkan file format HTML (Web Page, Filtered) dengan 

mengklik icon  dan klik Open 

 
o Pilih pengaturan teks pada toolbox 

  

 
 

 
o Blok paragraf kemudian pilih tool justify 
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Selain mengatur dan mengedit teks di layar Book View, 
pengaturan dapat juga dilakukan dengan perintah HTML dan CSS 
di layar Code View, seperti kode program dibawah ini digunakan 
untuk mengatur letak paragraf menjadi rata kanan dan kiri; 

 

<p class="MsoNormal" style="text-align: justify;"><a 
name="h.b4dmnfhsll3r"></a><b><span style="font-size:12.0pt; 
font-family:&quot;Calibri&quot;,&quot;sans-
serif&quot;">Abstract:</span></b><span style="font-family: 
&quot;Calibri&quot;,&quot;sans-serif&quot;"> </span><span 
style="font-family:&quot;Calibri&quot;,&quot;sans-
serif&quot;">This article discusses the implementation of 
comparative analysis for the campus information system using 
the Shared Hosting, Virtual Private Server or Dedicated Server on 
the internal campus. This paper limits the discussion of laying 
side and server implementations and not include campus 
information system software itself. Analysis seen from the aspect 
of implementation costs, technology, configuration and 
maintenance, location and server security.</span></p> 
 

Apabila ada kesalahan penulisan kode program maka akan 
muncul pesan kesalahan pada BookView, misalkan salah 
penempatan kode program maka pesan kesalahan akan muncul 
seperti berikut ini; 
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o Membuat daftar isi; pilih Tools->Table Of Contens->Generate Table 
Of Contens 

 
 

Sebelum melakukan Generate Table Of Contens pastikan 
konten telah diatur Heading nya terlebih dahulu. 

o Pengaturan Metadata 

 
o Membuat halaman sampul, ukuran gambar yang disarankan 

adalah 290x383 
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Lalu klik kanan gambar sampul untuk jadikan sebagai Cover Image 
 

 
 

o Menyisipkan gambar, audio, dan video; import terlebih dahulu 
gambar, audio atau video seperti langkah 8, kemudian lakukan 
pengaturan 

 
Untuk menyisipkan audio dan video, format yang didukung adalah 
MP3 dan MP4.  

o Meninjau ejaan untuk menghindari kesalahan pengetikan; pilih 
Tools->Spellcheck 
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Cek penulisan kata pada daftar kata yang termuat dalam tulisan, 
sebagai contoh kata untu  termasuk kata yang akan diperbaiki 
menjadi kata untuk. 

o Menyimpan file EPUB; pilih File->Save As. 
 

Readium: Aplikasi Pembaca EPUB 

Readium adalah salah satu file ekstensi Google Chrom yang 
digunakan untuk membaca file EPUB dan tersedia secara gratis. 
Adapun fitur-fitur yang disediakan adalah; 

 Dukungan menampilkan dan menyembunyikan daftar isi. 

 Tersedia beberapa mode baca seperti Nightmode. 

 Tersedia tampilan layar penuh. 

 Tampilan satu halaman dan dua halaman. 

 Dapat menampilkan video. 
Berikut ini petunjuk penggunaan Readium; 

1. Download dan install aplikasi di 
https://chrome.google.com/webstore/detail/readium  

 
2. Membuka file format EPUB; pilih add to library->from local file-

>pilih file->open 

https://chrome.google.com/webstore/detail/readium
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3. Tampilan Readium 

 
4. Menghapus library; Pilih Library->Details->Delete 

 
5. Selesai. 

 

Penutup 
Pembuatan karya ilmiah dalam format EPUB akan lebih 

memudahkan penulis dalam pengaturan naskah dan 
penyebarluasannya dengan bantuan Aplikasi Sigil dan Aplikasi 
Readium yang tersedia secara terbuka. Namun perlu ditegaskan 
kembali bahwa konten yang terlihat pada Aplikasi Redium bukanlah 
konten yang siap untuk dicetak  melainkan hanya untuk dibaca saja 
pada perangkat digital. Namun jika karya ilmiah diperuntukkkan versi 
cetak maka format PDF lebih cocok digunakan. 

Diakhir tulisan ini, penulis memuat salah satu karya ilmiah 
dalam format EPUB yang dapat di unduh pada laman 
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https://drive.google.com/file/d/0B4_dr3f4LuP3YndsanJxVE9qS0E/vie
w?usp=sharing 
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